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Score Client Points With Better
Account Management

A ONE-STOP SOURCE FOR UP-TO-THE-MINUTE JOB TOTALS -  PAGE  4

  he second worse thing you can tell a client is: “I’ll have to get
back to you on that.” (The absolute worst thing you can say is,

of course: “We seem to have, um, misplaced that information.”) No
matter how tactfully you put it, your client knows you lost that vital
info—and you know they know.
      It’s a sticky situation, and account executives face them everyday.
Whether they’re on the road or in the office, AEs need a good system
to track everyday details to stay on top of jobs while keeping the big
picture in focus. Clients & Profits can help.
     With Clients & Profits, office-bound AEs have all the information
they need just a few mouse clicks away.  And if they’re on the road, all
they need is a web browser and My Clients & Profits! to access the
database. When AEs have access to the information they need, they’ll
be able to better manage client relationships and profitability goals.

By Mindy Williams
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SCORE CLIENT POINTS

When AEs have access to the
information they need, they’ll be

able to better manage client
relationships and profitability

goals.  “The strength of Clients &
Profits,” says Craig Barnes, owner
of The MBC Group, “is that all of

that information is
always at their finger-

tips.”
The AE’s tools for

better account man-
agement begin with
the electronic client
file. The client file
maintains all of the
key client-related
information, like

contact names, phone
and fax numbers,

email addresses, web
site address, client

based projects, billing
rates, and budget

amounts.  “Our AEs
are proactive with

client budgets,” Craig
says, “and many times
they help the clients
set them up.”  AEs at

MBC have monthly AGI goals, and
they use Clients & Profits to ac-
tively track and forecast their

progress.
Since they know more

about new jobs than anyone else,
AEs at MBC add their own jobs,

whether they are on the road with

Continued from previous page

     Clients & Profits’ tools for better
account management begin with the client
account, which maintains all of the key
client-related information like contact
names, phone and fax numbers, email
addresses, web site address, client-based
projects, billing rates—and especially
budget amounts. “Our AEs
are proactive with client
budgets,” says Craig
Barnes, owner of The MBC
Group, “and many times
they help the clients set
them up.” AEs at MBC have
monthly AGI goals, and
they use Clients & Profits
to actively track and
forecast their progress.

Adding jobs on the road

     Since they know more
about new jobs than
anyone else, AEs at MBC
add their own jobs,
whether they are on the
road with My C&P! or in
the office. Estimates,
change orders, creative
briefs, automatic email,
and job reports help AEs
stay on top of their clients’
work. “The strength of
Clients & Profits,” says
Craig, “is that all of that information is
always at their fingertips.”

     Estimates, which can be revised any
number of times, can be approved online.
And once they’re approved, Clients &
Profits can automatically send an email to
production managers letting them know
that the job is a go. Change orders, which
can also trigger an automatic email,
include a checkbox to track client approval.
And getting a client’s signature on the

What do you like about
account management with

Clients & Profits?
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A recent survey asked: What do you like about

account management with Clients & Profits?

Their answers explain why so many shops use it

as their only agency management system.

■  Tracks all client-related billing information, in-Tracks all client-related billing information, in-Tracks all client-related billing information, in-Tracks all client-related billing information, in-Tracks all client-related billing information, in-

cluding billing rates, sales tax and finance chargescluding billing rates, sales tax and finance chargescluding billing rates, sales tax and finance chargescluding billing rates, sales tax and finance chargescluding billing rates, sales tax and finance charges

■ Job- and client-based diary entries recordJob- and client-based diary entries recordJob- and client-based diary entries recordJob- and client-based diary entries recordJob- and client-based diary entries record

everything about a client’s jobs and centralize andeverything about a client’s jobs and centralize andeverything about a client’s jobs and centralize andeverything about a client’s jobs and centralize andeverything about a client’s jobs and centralize and

document important communication with clientsdocument important communication with clientsdocument important communication with clientsdocument important communication with clientsdocument important communication with clients

■  Easily review year over year historical infor-Easily review year over year historical infor-Easily review year over year historical infor-Easily review year over year historical infor-Easily review year over year historical infor-

mation  about clients with details or summarizedmation  about clients with details or summarizedmation  about clients with details or summarizedmation  about clients with details or summarizedmation  about clients with details or summarized
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■  Various tools, such as the job snapshot andVarious tools, such as the job snapshot andVarious tools, such as the job snapshot andVarious tools, such as the job snapshot andVarious tools, such as the job snapshot and
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How do you compare?

■  93% use C&P for account management93% use C&P for account management93% use C&P for account management93% use C&P for account management93% use C&P for account management

■  Average number of AEs per shop:  6Average number of AEs per shop:  6Average number of AEs per shop:  6Average number of AEs per shop:  6Average number of AEs per shop:  6

■  76% of AEs always or mostly print their esti-76% of AEs always or mostly print their esti-76% of AEs always or mostly print their esti-76% of AEs always or mostly print their esti-76% of AEs always or mostly print their esti-

mates from Clients & Profitsmates from Clients & Profitsmates from Clients & Profitsmates from Clients & Profitsmates from Clients & Profits

■  75% of the shops surveyed require change75% of the shops surveyed require change75% of the shops surveyed require change75% of the shops surveyed require change75% of the shops surveyed require change

orders signed by clients.orders signed by clients.orders signed by clients.orders signed by clients.orders signed by clients.

■  26% use job and/or client diaries26% use job and/or client diaries26% use job and/or client diaries26% use job and/or client diaries26% use job and/or client diaries

■  Over 50% use  job creative briefsOver 50% use  job creative briefsOver 50% use  job creative briefsOver 50% use  job creative briefsOver 50% use  job creative briefs

■  AEs determine what’s to be billed in 56% ofAEs determine what’s to be billed in 56% ofAEs determine what’s to be billed in 56% ofAEs determine what’s to be billed in 56% ofAEs determine what’s to be billed in 56% of

shops surveyedshops surveyedshops surveyedshops surveyedshops surveyed

■  62% use the job summary or job progress as62% use the job summary or job progress as62% use the job summary or job progress as62% use the job summary or job progress as62% use the job summary or job progress as

their main prebilling reporttheir main prebilling reporttheir main prebilling reporttheir main prebilling reporttheir main prebilling reportContinued on the back page

final estimate and any change orders (even if
there’s no amount to charge) could save a lot
of grief when it comes time to bill the job.

Staying focused on client goals

     The creative brief, also part of the job
ticket, keeps everyone on the same page.
Using the creative brief fields, AEs can define

the job as a strategic
process, present it for client
approval, then refer to it as
the job unfolds.  Greg Eckel,
president of Design Crew
Marketing Solutions, uses the
creative brief to keep
everyone—clients, vendors,
and staff—focused on the
clients’ goals. “Clients &
Profits is our process,” he
says, “and using it builds a
level of trust with our
clients.”

     Each major turning point
in a job (like status changes)
is automatically recorded in
the job diary. Manual entries
can be added, too, then
emailed to any staffer—or
even the client—to record
important job information.
“I always use the job diary
to record all communication
with a client about a job and
everything that happens of

note,” says Shaun Schleif, AE at David &
Associates. Staffers can also add job diary
entries when they’re adding notes to their
time cards just by clicking a checkbox in the
time card window.

Job diaries, access privileges

     Each client account also has a diary, and
anyone with the right access privileges can



SECRETS FOR ACCOUNT MANAGEMENT SUCCESS

Job progress--
AE’s window into
job profitability

The “bottom” bottom-line is job profit. The trick

is to get AEs motivated to achieve it. The way to

motivate them is to give them the tools to see it

for themselves.

Marty Pennoni, a long-time Clients &

Profits user and consultant, says, “I tell

every client that the most important report for

job management is the Job Progress. If jobs are

estimated correctly, hourly rates set correctly,

and the company is staffed correctly, (basically

doing everything owners should do), it's a simple

matter: Manage your job costs at gross to finish

at or under the estimate.  If you do this consis-

tently, you will be profitable.”

Job progress is a report...and much, much

more! It’s an entire job management area

within each job ticket. (Choose Edit > Job

Progress to open the window.) AEs quickly de-

termine how an entire job is progressing through

focusing on each task’s budgeted vs. actual

amounts, along with showing percentage of

completion for each task and the job as a whole.

And AEs can change their view to tasks

belonging to a certain group through a

pop-up menu. So, for example, they can zero in

on the account service, creative or production as-

pects of the work. This ability reveals and pin-

points potential problems well before comple-

tion, enabling AEs to be proactive with clients.

If an AE has questions about individual

costs, they can highlight that task or

tasks, then click the Costs button. All transaction

details appear for easy review. Also, task billings

and purchase, insertion and broadcast orders are

reviewed in the same way.

MY CLIENTS & PROFITS! IS YOUR
ROAD WARRIOR

     The fastest, easiest way for AEs to add
new jobs into your Clients & Profits database
is to enter them right from the client’s office
using My Clients & Profits!, the web server
add-on for Clients & Profits. With My Clients
& Profits! and a phone jack, AEs can access
your office’s Clients & Profits database as
quickly as they can log onto the internet.
     With just a few mouse clicks, AEs can
add, view, and edit job tickets, estimates,
creative briefs, job costs, billing status, and
more.  They can also review client and
vendor information for status or billing
notes—a key step to help avoid costly
delays and embarrassing mix-ups.
     AEs can stay in touch with the home
office from their hotel rooms, the airport, or
the corner coffee shop (okay, even the beach
if they have a modem, but they’ll never
admit it). With My Clients & Profits!, AEs can
achieve three goals:

■ They’ll spend less time in front of a
computer at the office and more time
interacting with clients. That means more

work for your shop, and bigger commissions
for them.

■ They can get up-to-the-minute informa-
tion to take into a client meeting, even
when they’re on the road. Clients will be
wowed and think you guys are super heroes.

■ They can enter new jobs, change orders,
or important information right away so your
production staff can start working almost
immediately.  Faster turnaround can give you
a competitive edge—and you’ll minimize
staff downtime.

     My Clients & Profits! lets AEs add out-of-
pocket expenses they incur on the road
(e.g., client lunches, lodging charges, etc.)
when they happen.  By keeping on top of
expense reports, AEs can better handle their
work-related cash flow, and accountants can
better plan for issuing reimbursements.

Judith Hector is the Clients & Profits
marketing manager. She can be reached at
judith@clientsandprofits.com.

By Judith Hector



JOB PROGRESS
A one-stop source for a job’s up-to-the-minute estimate, hours, and costs

The Job Progress report is a client report that
shows up-to-date totals for a job. It’s ideal for
making your point at client meetings, since the
client will see each job's estimate, hours, and
costs—but with markups and commissions, not
the actual costs. Clients (and nosy staff
members) won't see they agency's cost rates,
either.

1. You can print Job Progress reports for one job at
a time or for a range of jobs for one client. By
entering a range of production or billing status
codes, you can see which jobs are stalled, pending
client approval for example. By focusing on certain
status ranges, you’ll know which jobs—or clients—
need follow up.

2. The Job Progress report gives an at-a-glance
overview of the job’s estimate, change orders, and
actual amounts spent so you’ll know if costs and
time are on track. By keeping tabs on this critical
information, AEs can either rein in the job to keep
it’s spending on track—or approach the client with
a change order.

3. Each of the job’s tasks is listed with estimated
amounts, followed by costs (including change
orders, labor, and open POs,) and billing amounts.
You’ll be able to see how the costs for each line
item are contributing to the job’s profitability.

4. The Estimated Hours and Actual Hours columns
compare how many hours were planned to
complete the job versus time spent so far.  A quick
comparison between estimated and actual labor
hours and the production status will send up a red
flag for any potential pitfalls, while there’s still time
to make changes.

5. The Open POs column tells you not only the
dollars committed to a task, but also whether or not
a PO has been issued.  If there’s no amount in the
open POs column and billings don’t match the
estimate, you can bet a PO hasn’t been issued yet.

6. Every kind of cost is included, i.e., time, A/P,
expenses, internal charges, job cost transfers and
check amounts directly costed to the job. The gross
(billable or marked up) amounts are subtotaled by
task providing important task by task totals as well
as total gross costs for this job.

Choose View > Job Tickets then choose File > Reports. Click on the Job Accounting link then select the Job Progress report.
To print the Job Progress report:

Clients & Profits Sample DATA

Job Progress
REE-308 Gateway Plaza Newsletter

Number:
Client:

REE
Reynolds Electronics

Project:
Gateway

Production Status: 500
Ready to Billing Review

Type:
Newsletter

Task: Description:

Estimate: Chg Orders: H

ADD Art Direction

360.00
--

CCM Comprehensive Layout
270.00

--

Creative

630.00
--

CTP Typesetting

90.00
--

PRD Mechanical Art Assembly
140.00

--

COL Color Marking

90.00
--

CLY Computer-Aided Layout
300.00

--

CPR Computer-Aided Production
540.00

--

Production

1,160.00
--

CGP Computer-Generated Color
96.00

--

Fulfillment

96.00
--

PJC Project Coordination
80.00

--

Account Management
80.00

--

PA
Project Administration

70.00
--

Administration

70.00
--

TOTAL:

2,036.00
-

Specifications:

q

e

w
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AE/Team: SAG

Est. Actual
Labor, Costs

Hours: Hours: Open POs: @ Gross:
Billings: Unbilled:

4.00 6.00
--

540.00
360.00

180.00

3.00 2.00
--

229.68
270.00

-40.32

7.00 8.00
--

769.68
630.00

139.68

1.00 1.00
--

90.00
90.00

--

2.00 1.00
--

70.00
140.00

-70.00

1.00 1.00
--

90.00
90.00

--

3.00 3.00
--

300.00
300.00

--

6.00 6.00
--

540.00
540.00

--

13.00 12.00
-- 1,090.00 1,160.00

-70.00

-- --
3,481.31

36.32
96.00

-59.68

-- -- 3,481.31
36.32

96.00
-59.68

1.00 1.75
--

140.00
80.00

60.00

1.00 1.75
--

140.00
80.00

60.00

1.00 --
--

70.00
-70.00

- 1.00 --
--

70.00
-70.00

-- 22.00 21.75 3,481.31 2,036.00 2,036.00
--

Estimate + Change Orders:

2,036.00

Estimate Remaining:

0.00

Hours Remaining:

0.25

Gross Costs + Open POs:

3,567.31

Advance Billings:

--

t

y

u
i

o

s
a

r

p

7. Billed amounts from posted A/R invoices
are listed by task and totalled for this job
showing the AE any previous billings.

8. The Unbilled column shows the total
costs, time, and expenses that are ready to
be billed now. It increases whenever A/P,
time cards, and expenses are posted, then
reduced when the job is billed. It always
shows the difference between the job’s total
gross costs less billings.

9. The Estimate + Change Orders amount
reflects the total amount the client has
agreed to pay for the work.

10. The Estimate Remaining amount shows
the job’s total estimate less its billings to
date. It lets you know how much money is
left to spend on the job.

11. The Hours Remaining amounts show the
job’s total estimate hours less its actual hours
posted from time cards. You’ll zero in on the
labor portion of this job to see how many
hours are left to complete the work.

12. The Gross Costs + Open POs amount is
the sum of outside costs (from A/P),
including markups, plus open POs/IOs/BOs.
You’ll know the total outside costs associated
with this job.

13. If the job was billed in advance, you’ll
see the amount of its advance billing here.
This total decreases when advance billings
are applied to subsequent job billings.

d



Q.  I’m an AE with over three dozen
clients. How can I monitor the status of
hundreds of their jobs?

Monitor all your clients’ work through a nifty
little field called AE/Team. Your initials are
entered on all your clients and copied to
each of their new jobs. Many job reports are
printed for only your AE/Team initials,
pinpointing the informa-
tion you need to see. Print
the Daily Job Status report
to review where each of
your clients’ jobs are in
their development, based
on your shop’s production
status codes. This provides
a big picture overview.

Q. How can I get schedul-
ing details for all my jobs
without tracking down
our traffic manager?

Because all of your client’s
jobs have your AE/Team
initials, you can print most
of the scheduling reports
for your initials only. This
provides a task by task
breakout of scheduled work
for all your clients. You’ll
see when the work starts
and is due, as well as who
is assigned to do the work.
One of many reports to
print is the Work To Do. (Choose View > Work
To Do, select the “Due for AE/Team” option ,
enter your initials, then enter work date
range.)

Q.  I have many large corporate clients
who have dozens of billing contacts and
different billing addresses. How can I
keep this all straight at billing time?

Use divisions to track accounts for large
corporate clients. First add a client that

ACCOUNT MANAGEMENT QUESTIONS AND ANSWERS

These Clients & Profits users  share their tips on how

they manage their client accounts better:

Do it in writing and get it signedDo it in writing and get it signedDo it in writing and get it signedDo it in writing and get it signedDo it in writing and get it signed  “Do not start any jobs

until you have a signed contract. Do change orders as

soon as the client requests something beyond the

original contract. Make sure the client signs the change

order before doing the additional work” says Laurie

Wilkinson of Reed Sendecke Inc. “There must be a pur-

chase order for every outside cost incurred on a job

and it must be signed off by someone with the proper

authority.”

Status codes mean businessStatus codes mean businessStatus codes mean businessStatus codes mean businessStatus codes mean business “On a daily basis, our AEs

use the production and billing status codes to produce

reports that enable them to take action,” says Donna

Lipp of The Hemisphere Group Inc. “They know what

jobs are with clients, what jobs need signed esti-

mates, what jobs are at the vendor and what jobs are

closed and ready to bill.”

Document, document, document Document, document, document Document, document, document Document, document, document Document, document, document “Put everything that

someone may want to know, now and in the future, in

the job and/or client diaries,” says Tami Lester of Wil-

son Chapman. “Review the information in the diaries

often. You can learn a lot about clients’ habits, as well

as your shop’s.”

They bought it; so use itThey bought it; so use itThey bought it; so use itThey bought it; so use itThey bought it; so use it “Use Clients & Profits and all

of its features—they are an AE’s friend,” says

AnneMarie Greene of The MBC Group. “It’s so simple

to use areas like estimates and creative briefs. Plus,

everything is easy to find and monitor because it’s all

in one database, tracked by job number.  I also like the

billing windows and reports, like the job snapshot and

job summaries. They help monitor a job’s profitability

- examining both time spent and outside costs.”

They bought it; so use it, pt. 2 They bought it; so use it, pt. 2 They bought it; so use it, pt. 2 They bought it; so use it, pt. 2 They bought it; so use it, pt. 2 “Use every resource

available to you provided by Clients & Profits,” says

Felica Sparks of Benton Newton & Partners Advertis-

ing. “Do not be a lazy AE!”

serves as the main client. Then, add each
different billing address with its correspond-
ing contact as a separate client. In each
subsequent client’s division area, enter in
the client code for the main client. You’ll
always know which clients belong together
by their division information. And at billing
time, the right billing address and contact
will be listed on the client’s invoices with no

rekeying of information. (In
Clients & Profits Pro and C&P
SQL you’re also able to
reunite clients that belong to
a single division when
printing client account
agings and statements.)

Q.  My production and
creative co-workers
constantly asking about
creative, production and
marketing goals of jobs.
What can I do to inform
everyone and keep from
having to repeat myself?

Use a job’s creative brief to
provide staffers who need to
know about the work’s
creative, production and
marketing goals. It is a
permanent part of a job
ticket and centrally located,
so it’s there any time
someone needs to refer to it.

Q.  I want to review on a weekly basis all
of my client’s outstanding invoices.
What’s the easiest way?

Use a client account aging printed for your
AE/Team initials only. The subsequent aging
has unpaid invoices for your clients only.
It’s a great way to stay informed on who’s
paying and who’s not. Cash flow for your
shop is so important to its financial health.
You could call clients whose invoices are
past due.

Monitor all yourMonitor all yourMonitor all yourMonitor all yourMonitor all your
clients work through aclients work through aclients work through aclients work through aclients work through a
nifty little fieldnifty little fieldnifty little fieldnifty little fieldnifty little field
called AE/Team.called AE/Team.called AE/Team.called AE/Team.called AE/Team.

Your initials areYour initials areYour initials areYour initials areYour initials are
entered on all yourentered on all yourentered on all yourentered on all yourentered on all your
clients and copied toclients and copied toclients and copied toclients and copied toclients and copied to
each of their new jobs.each of their new jobs.each of their new jobs.each of their new jobs.each of their new jobs.

Many scheduling andMany scheduling andMany scheduling andMany scheduling andMany scheduling and
job reports can printjob reports can printjob reports can printjob reports can printjob reports can print
for only your AE/Teamfor only your AE/Teamfor only your AE/Teamfor only your AE/Teamfor only your AE/Team
initials pinpointinginitials pinpointinginitials pinpointinginitials pinpointinginitials pinpointing
the information youthe information youthe information youthe information youthe information you
need to see.need to see.need to see.need to see.need to see.

GUARANTEED GREAT IDEAS!
Account Management Tips from Real

Clients & Profits Users



WORKING SMARTER EVERY DAY

Six Slick Account
Management Reports

Knowing and reviewing the right reports makes

all the difference between being proactive with

clients and staff or letting details slip through.

To successfully manage their client accounts,

AEs often use these reports:

AE List by AE/Team: AE List by AE/Team: AE List by AE/Team: AE List by AE/Team: AE List by AE/Team: Shows the percentage of

estimate remaining for each job and a subtotal

for each client. With each job’s production sta-

tus identifying where a job is in its develop-

ment, AEs can take action if a job is about to

go over estimate.

Client Time by Task: Client Time by Task: Client Time by Task: Client Time by Task: Client Time by Task: Quickly review all time

entered for each client subtotaled by task. See

how staff time was spent on each client for a

given date range. Individual time entries don’t

appear on this report, so you get the big pic-

ture overview.

Job Billing Worksheet by AE: Job Billing Worksheet by AE: Job Billing Worksheet by AE: Job Billing Worksheet by AE: Job Billing Worksheet by AE: A prebilling report

that shows important dollar amounts for AEs

to review before determining what’s to be

billed. There’s even a designated area for AEs

to write amounts to be billed or instructions to

the biller.

Work To Do for AE/Team: Work To Do for AE/Team: Work To Do for AE/Team: Work To Do for AE/Team: Work To Do for AE/Team: A scheduling report

that shows AEs all scheduled work for their cli-

ents. No more tracking down the traffic man-

ager to learn who’s doing what and when.

AE Client Invoice Aging:  AE Client Invoice Aging:  AE Client Invoice Aging:  AE Client Invoice Aging:  AE Client Invoice Aging:  An accounting report

that shows outstanding Accounts Receivable

invoices for an AE’s clients. No more tracking

down the business manager to find out who

has paid and who hasn’t.

Change Order by AE: Change Order by AE: Change Order by AE: Change Order by AE: Change Order by AE: With changes happening

quickly on jobs, this report tracks what the

changes are and whether or not they’ve been

approved by clients.

notable or critical to a job’s development.
     AEs often need to review the diary
entries they added themselves, which is easy
to do. In the Job Diary window, choose the
pop-up menu to show "user generated
entries only." Entries made by C&P are then
temporarily hidden, showing only those
added manually.
     A manual entry can be sent via C&P
email to any staff member, or even to a
client by typing their email address onto the
cc: line, to immediately inform them of the
news.
     Even document any mistakes that were
made during the job. Reviewing a job diary
for any previously made errors can help in
preventing them from reoccurring. Use job
diaries to keep all job-related details, even
the ones you’d rather forget, in one, easily-
accessible location.

THE JOB DIARY:
REMEMBER EVERYTHING

 Job diaries are the way to keep
up to date on a job’s "happen-
ings." Not only does Clients &

Profits track job activity and history through
automatic entries, AEs can also document
meetings, changes, calls, etc. by entering a
manual job diary entry.
     Recording every detail in the diary
consolidates all information for easy
reference rather than trying to track down
staffers or locate job jackets to obtain
pertinent job information. A diary entry
shows when, what, and who was involved
with an activity and/or change. Added and
saved very quickly, they are sorted by the
date they were added, by who added the
entry or took the action, and by what was
done (also known as their subject).
     Also, as a staffer is adding their time
card, any individual time entry’s description
can be automatically recorded as a diary
entry. Taking this action should be reserved
for time entries that are in some way
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add and email a note. For example, if a client
requests a strategy meeting to discuss next
year’s promotion plan, the AE can add an
entry in the client diary, then email the entry
to the creative director and the client.

No-brainer billing

     AEs can print dozens of reports that select
information based on the AE/Team sort field
(this is usually the AE’s initials). They can
track their own jobs’ costs, billings, purchase
orders, change orders, and traffic and
schedules. They can also quickly gather
information, both current and historical, on
all their clients without having to track down
a harried manager or dusty job folder.

     The exclusive Job Snapshot shows in an
instant how close the job is to completion.
“Billing is a no brainer now,” says Lisa
Tuckett, the senior account manager at
Hodgson/Meyers Communications. “Our billing
time has been cut by three-fourths with C&P.”
AEs lay the groundwork for the accounting
department with reports like detailed job
summary, job commitments and unbilled job
costs. “If the estimate is properly done,”
Lisa says, “all the billings for the job are as
expected, and the clients become really, really
comfortable with our entire work process
using Clients & Profits.”

Easy review of internal, external costs

     To stay current on the work, AEs can print
a Daily Job Status report showing their own
jobs. Many other reports can be printed for
one AE, making it easy to pinpoint their
clients’ work. The Job Progress gives AEs a
quick look at all costs for a job, with the
ability to zero in on select groups. They can
also review internal and external costs with
the budgeted vs. actual detail. And job costs
are only a mouse-click away.

     The profitability reports can be sorted by
client, giving details for each job or an
overview by client. These reports are great
tools for figuring out which clients actually
add to the bottom line. Profitability is taken
a step further in Clients & Profits with the
Client P&L Analysis, a report that factors in
the shop’s overhead before determining a
client’s profitability.

     Account management runs a full circle,
from winning good clients and keeping them
informed, to sharing job details with the rest
of the staff, to billing promptly and accu-
rately. Remember, there is no such thing as
too much communication. With Clients &
Profits, AEs communicate easily with both
clients and staffers. “Our AEs often give our
clients financial information about their jobs
well before the client could get that informa-
tion from their own business,” Craig says.
Now that’s account management!


